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Workspace – Draft View (PC version) 
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Workspace – Draft View (Mac version)  
 

 
 
 
  

This color palette is a 
floating toolbar and may 
appear in a different 
location on your screen. 
screen 
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Tool Bar – Basic Commands 
(icons only show for the PC version) 

New File 

 

New File - Creates a new document with the default settings from the 
application's preferences and opens a draft view for it.  

PC = Ctrl + N 

Mac = Command + N 

File Open 

 

File Open - Opens a DTX or WIF file and displays it in a draft view.  

PC = Ctrl + O 

Mac = Command + O 
 

File Save 

 

File Save - Saves the file in DTX or WIF format using the original filename, if 
any. Use the File  ®  Save As command from the menu bar to save the file 
under a new name or formant (.dtx vs .wif)   

PC = Ctrl + S 

Mac = Command + S 
 

Preview and Print 

 

 

Preview and Print - Opens the print preview window which contains options 
for printing the active view in WYSIWYG fashion (what you see is what you 
get).  

PC = Ctrl + P 

Mac = Command + P 
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Undo  

 

Undo – Backs up one action  

PC = Ctrl + Z 

Mac = Command + Z 

Cut  

 

Cut – Removes selection  

PC = Ctrl + X 

Mac = Command + X 

Copy 

 

Copy – Saves the selection into the computer’s memory.  

PC = Ctrl + C 

Mac = Command + C 

Paste 

 

Paste – Places the selection in the computer’s memory.  

PC = Ctrl + V 

Mac = Command + V 
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Drafting Tools – PC and Mac 

Straight Draw 

 

Straight draw –May be used to insert a single end or pick with a single 
mouse click.  It may also be used to click-and-drag to create a straight in the 
threading, treadling, or tie-up. 

 

Point Draw 

 

Point draw – May also be used to click-and-drag a point line in the 
threading, treadling, or tie-up. 

 

Line Draw 

 

Line draw – Draws a stepped line along the diagonal of the rectangle from 
where you clicked down to the current cursor location. This style can be used 
for profile drafts. 

 

Draw Freehand 

 

Freehand draw – Draws directly into the threading or treadling draft. 
Unlike the straight, point, and line draw tools, in freehand mode the mouse 
tracks exactly on the line.  This style is used mostly for profile drafts and 
creating network drafts.  

 

Draw on Network 

 

Draw on network – Draws onto a network based on a 1:3 twill initial, 
with 
network lines running left or right respectively. The mouse should follow the 
overall shape of the line you are drawing, as for freehand mode.  
 
This is one mode where you should not try to click one square at a time, 
since drawing does not take place exactly on the mouse hotspot. 
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Select Rectangle 

 

Select rectangle – This tool allows you to select a rectangular area in 
threading, warp color bar, treadling, weft color bar or tie-up. A selection 
rectangle is outlined in blue to distinguish it from a red drawing rectangle. 
Click down in one corner and drag out until the rectangle covers the desired 
area.  The contents of the selection rectangle can then be used in Cut, Copy 
or Transform operations.  
 
To use the Select tool, click the toolbar button. The cursor will become a 
pointer 
instead of a pencil to indicate the mouse is selecting rather than drawing. 
While the cursor is a pointer inside the drawdown frame, you can’t draw, 
apply color or change thread thickness with the mouse. When you have 
completed the task required using the selection tool, click a red drawing tool 
icon when you need to draw again. 

 

Pickup Color 

 

Pickup color – The pickup color tool looks like an eyedropper.  It is used to 
select or re-select a color that appears in the warp or weft color bars. When the 
tool is active, the cursor becomes an eyedropper. 
 
Position the eyedropper on the warp or weft color in the color bar you want to 
select.  When you click with the left button on the color using pickup tool, the 
color becomes the main working color (upper left square).  
 
Use this tool when the palette contains several similar colors, and you can’t 
remember which was used previously. After you have clicked a color, the 
drawing tool previously used is restored. You must click the pickup color tool 
again if you need to select another color. 

 

Insert Tool 

 

PC 

Insert tool – The insert tool pushes threads apart to make a gap for adding 
warp ends, weft picks, or treadles in the tie-up. First move the insertion point 
onto the end or treadle where you want create space. The insertion point is 
usually wherever you last clicked or released the mouse button. Each click of 
the toolbar button or each keystroke either adds one empty thread (spacebar or 
insert button). 
 
PC = Insert button 
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Mac 

Mac = Spacebar 

Delete Tool 

 

PC 

 

 

Mac 

Delete tool – The delete tool removes warp ends, weft picks, and treadles. 
First move the cursor to the location where you want to remove ends or 
treadles. Remove ends by clicking the left mouse button or clicking on the 
delete button. 

PC = Delete button 

Mac = Delete button 

 

Increase or Decrease Size of Draft 
 

 

PC 

 

 

Mac 

Increase or Decrease the Size of the Draft – Click on these buttons 
(PC) or sliding the arrow on the bar (Mac) will make the size of the draft 
increase (+) or decrease (-) 

PC = Ctrl + + and Ctrl + - 

Mac = Command + + and Command + - 
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Help Function – PC version 
 
Help  ®  Help Topics 
 
To search how to use many functions in Fiberworks, go to the Help menu.  This menu may be 
found on the tool bar on the far-right side.  You may enter key words in the Search entry field to 
find what you are looking for. 
 

 
 

 
By selecting Help Topics, the screen below will open.  From this screen, it is possible to search 
on a keyword, view Help contents, or view the Help index. 
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Help Function – Mac version 
 

Help  ®  Search entry and Fiberworks Help 
 
To search many functions in Fiberworks, go to the Help menu.  This menu may be found on 
the tool bar on the far-right side.  You may enter key words in the Search entry field to find 
what you are looking for. 
 

 
 

 
By selecting Fiberworks Help, a window appears. 
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Making a Simple Draft 
 
How to Add and Delete Warp ends, Weft Picks, and Treadles 
 
To add or delete one end at a time or freehand lines 
 

 
 

 
Select the appropriate drawing tool.  Your cursor will change to a pencil.  
 
• To add one warp end, click the left mouse button once in the threading area.   
• To add a series of continuous warp ends, click and hold down on the left mouse button and 

drag across the threading area.  A red box will outline the area 
 

 
 
• On a PC  

o To delete one warp end, double click with the left mouse button on the warp end 
you want to delete. 

• On a Mac . . . 
o To delete one warp end, click the right mouse button on the warp end you want to 

delete or double click with the left mouse button. 
o To delete a series of continuous warp ends, click and hold down on the right 

mouse button and drag across the threading area. 
 

 
 
Repeat Threading or Treadling Sequence 
 
Warp  ®  Repeat or Treadling ®  Repeat 
 
 
From this window, it is possible to set the following parameters: 

• Repeat the threading or treadling sequence, warp or weft colors, and warp or weft 
thickness. 

• Number of repeats (as the number of repeats is increased or decreased, the number of 
threads will change) 
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Under Repeat Type, a menu of repeat options are shown  
 

 
 
The Step By entry point is used for advancing and descending sequences 
 
 
Flip Threading or Treadling Sequence 
 
To repeat a warp threading or weft treadling sequence, choose Flip Sequence from the Warp 
or Treadling menu. 
 

 
 
Make Symmetrical – Adds a reversed sequence   
 
Reverse Sequence - Replaces the original sequence with a reversed sequence 
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Editing in the Drawdown – It is possible to edit the tie-up of the draft by clicking in the 
drawdown of the draft.  This will change the tie-up or the liftplan. 
 

 
 
 
Entering Warp Ends and Weft Picks using the Keyboard 

A threading or treadling pattern can be entered using the keyboard instead of using the mouse. 
This can be an efficient way to enter a threading or treadling sequence. 

To enter a pattern, click on the starting point in either the threading or treadling window and type 
in the shaft (or treadle) numbers starting with that end (or pick).  

For numbers greater than 10, the row of keys below the number keys will enter warp ends or 
weft picks.  For example, ‘q’ 11, 'w' for 12, and so on.  See the diagram below for which keys 
will enter ends on which shafts or treadles. 

 

Click inside of 
the drawdown 
area to edit the 

tie-up 
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Entering Ends using Menus 

A threading or treadling pattern can be added from the Warp and Treadling menus. 

PC Mac 
Warp  ®  Fill 
or 

Treadling ®  Fill 
 

 
 

Warp  ®  Fill Threading  
or 

Treadling ®  Fill Treadling 
 

 

 
 
Copying a Threading or Treadling Selection 

Step One - Click on the Select Rectangle tool in the tool bar    
 
Step Two - Click and hold down on the left mouse button and drag across the threading area.  A 
blue box will outline the area.  

 
 
Step Three – To copy the selection , select Copy from the Edit menu or using keyboard 
commands (e.g., PC = Ctrl + C and Mac = Cmd + C) 
 
Step Four – Click on the entry point of the copied selection.   
 

 
 
Step Five –To add the copied selection, select Paste from the Edit menu or using keyboard 
commands (e.g., PC = Ctrl + V and Mac = Cmd + V) 
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Filling a Tie-up – It is possible to automatically fill a tie-up with a twill tie-up.  For example, for 
a 3/1/1/3 tie-up, fill-in the tie-up for the first treadle  
 

 
 

PC Mac 
Tieup  ®  Twill Repeat 
 

 

Tieup  ®  Diagonal Repeat  
 

 
 

 
The remaining treadles in the tie-up will fill based on the parameters chosen in the above 
window. 

 
 

Treadling Tools 
 

Multiple Treadles - When a Draft Requires Multiple Treadles for a Single Pick 
 

PC Mac 
Tieup  ®  Allow Multipedal Treadling Treadling  ®  Allow Multipedal 

Treadling 
 

 
 

Weave as Drawn In/Tromp as Writ 
 

Treadling ®  Weave As Drawn In  
 
By choosing this command, the treadling sequence will be populated with the warp threading 
sequence.  In the weaving community, this command may also be referred to Tromp as Writ. 
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Adding and Removing Tabby 
 

PC Mac 
Treadling  ®  Add Tabby 
 

 
 
Treadling  ®  Remove Tabby 
 

Treadling  ®  Insert Tabby 
 

 
 
Treadling  ®  Remove Tabby 
 
 

 
Without Tabby With Tabby Added 
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Tie-up Tools 
 

Sinking Shed – This will adjust the draft’s tie-up for a sinking shed (e.g., counterbalance) 
loom 
 
Convert to Liftplan – If working with a tie-up, this will automatically redraw the treadling 
sequence into a liftplan for a direct tie-up or table loom.  
 
Convert to Tieup– If working with a liftplan, this will automatically redraw the treadling 
sequence into a tie-up and single treadle treadling sequence.  
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Cloth View  
 

The fabric views are useful for visualizing the entire draft, while still editing the draft at a 
larger magnification level. 

 
Cloth menu – For both the PC and Mac versions, the view of the fabric may be 
changed (e.g., warp faced, interlacement, etc.) 

 

 
 
 
 
Fabric Back 
 
To view the back of the fabric, choose from the View menu or click on the Back View (PC) or 
View Back (Mac)  
 

PC Mac 
View  ®  Back View 
 
or from the menu bar 
 

 

Cloth  ®  View Back 
 
or from the menu bar 
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Color and Color Palettes 
 
Color Palette – For the PC version, the color palette appears to the right of the draft screen.  
For the Mac version, the color palette is on a floating tool bar.  Click-and-drag to reposition it.   
 
 

 

PC Color Palette 
 

 

Mac Color Palette 
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Color Bar 
 

Above the threading and to the right of the treadling is a narrow area.  This area is the color 
bar.  By clicking in the space, a blinking cursor will appear. 

 

 
 
Adding Color 
 

There are three ways to add colors to a draft: 
• Keyboard  
• Mouse 
• Menu  

 
Keyboard Method of Entering Color 

 
Next to each of the colors on the color palette (shown on the previous page) is a letter, 
number, or punctuation.  Typing the character on the keyboard while the cursor is in the 
color bar will enter the associated color  
 

 
Mouse Method of Entering Color 
 

The top two colors on the color palette show which color will be added to the color bar 
on a mouse click. 

• Left-click on the mouse will enter the color on the left  
• Right-click or a double left-click will enter the color on the right  

 

  
Click-and-drag with the left or right button to fill the color bar with a color. 
 
To change the color in the top two boxes on the color palette using the mouse, click on 
any color in the palette.  A left click will place the color in the left box and a right click or 
double click with the left button will place the color in the right box. 

 
 

  

Color bar 

Left-click color 

Right-click or double click color 
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Menu Method of Entering Color 
 

PC Mac 
Warp  ®  Colors 

 
or 
 

Treadling  ®  Colors 
 

 
 

The above tool will allow up to two colors to 
be selected.  The pattern pull-down menu 
allows the following sequences to be filled: 

• All threads (one color) 
• A-B (odd-even) 
• A-A-B-B 
• A-B-A 
• A-B-B-A 
• A-B-B-B 
• A-A-A-B 

 

Warp  ®  Fill Warp Colors 

 
or 
 

Treadling  ®  Fill Weft Colors 
 

 
 
To change the color in the boxes, click-and-
drag a color from the color palette and drop it 
into the appropriate box. 
 
The above tool will allow up to four colors to 
be selected.  The pattern pull-down menu 
allows the following sequences to be filled: 

• Single Color A 
• A-B (odd-even) 
• A-A-B 
• A-A-A-B  
• A-A-B-B 
• A-A-A-A-B-B 
• A-A-A-B-B-B 
• A-A-A-A-B-B-B-B 
• A-B-C 
• A-A-B-C 
• A-B-A-C 
• A-A-B-B-C-C 
• A-B-C-D 
• A-B-A-C-A-D 
• A-A-B-B-C-C-D-D 
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Pickup Color -  
 

The Pickup Color tool looks like an eyedropper.  It is used to select or re-select a color that 
appears in the warp or weft color bars. When the tool is active, the cursor becomes an 
eyedropper. 
 
Position the eyedropper on the warp or weft color in the color bar you want to select.  When 
you click with the left button on the color using pickup tool, the color becomes the main 
working color (upper left square).  

 
 

Changing Palette Colors – PC version 
 
By clicking on the top two colors on the color palette, the window below will appear.  The color 
at the top on the right is the original color.  As adjustments are made to the parameters, the color 
on the left will change.   
 
To go back to the original color, click on the Revert button.  To close the window and return to 
the color palette with the color adjusted, click on the Close button. 
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Changing Palette Colors – Mac version 
 
By clicking on the top two colors on the color palette, a window opens with five different 
options.  
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Create a Color Gradient (Mac version only) 
 

Colors  ®  Create Gradient 

 
The Create Gradient tool allows a graded series of colors to be created.  
 
Choose the Start and End colors by clicking and dragging a color from the color palette and 
dropping onto the left and right end of the gradient strip respectively.  The number of unique 
colors and number of threads will create different effects. 
 
When choosing the number of unique colors, the same number of matching yarns is required. 
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Properties for Draft and Project 
 

Changing the Number of Shafts and Treadles 
 

PC Mac 
Tieup  ®  Shafts and Treadles 

 

 
 

Tieup  ®  Shafts and Treadles 
 

 

 
 

 
Changing Preferences – PC version 

 
File  ®  Preferences 

 
This panel allows the standard characteristics to be changed and applied for all new drafts 
when File ® New is chosen. These settings do not affect drawdowns already on the screen 
or saved drafts.  There are three different Preferences and Initiate Setting windows: 
 
New Design Settings 
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Print Settings 
 

 
 
Miscellaneous Settings 
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Changing Preferences – Mac version 
 

Fiberworks  ®  Preferences 
 

This panel allows the standard characteristics to be changed and applied for all new drafts 
when File ® New is chosen. These settings do not affect drawdowns already on the screen 
or saved drafts. 
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Notes and Records 
 

Cloth  ®  Notes and Records 
 

This menu item opens a window with three tabs: 
 
Notes – allows entry of information for a draft and/or project. A button allows you to insert 
a records template.  Below is the information that may be entered. 
 

PC Mac 
 
WARP DESCRIPTION 
 
Warp Yarn:      
Count:          
Color:          
Cost, source:   
Warp length:    
Warp width:     
Sett:           
Reed:           
Sley:           
# Ends:         
Weight:         
 
WEFT DESCRIPTION 
 
Weft yarn:      
Count:          
Color:          
Cost, source:   
Weight:         
 
FINISHED PRODUCT:  
 
Dimensions:     
% shrinkage:    
Ends per inch:  
Picks per inch  

 

 
WARP DESCRIPTION 
 
Warp Yarn:      
Count:          
Color:          
Cost, source:   
Warp length:    
Warp width:     
Sett:           
Reed:           
Sley:           
# Ends:         
Weight:         
 
WEFT DESCRIPTION 
 
Weft yarn:      
Count:          
Color:          
Cost, source:   
Weight:         
 
FIBER CONTENT:  
 
Dimensions:     
% shrinkage:    
Ends per inch:  
Picks per inch  
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Heddles used per Shaft – Shows the number of heddles used per shaft. 
 

 
 
Thread Counts by Color - Shows the use number of ends for each color in warp and weft. 
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Float Search 
 

Tools  ®  Float Search 
 

To use Fiberworks to help identify excessive floats in the warp and weft, from the Tools 
menu, choose the Float Search selection.  The PC and Mac versions perform this function 
in different manners. 
 
Float Search – PC version 
 
Tools  ®  Float Search 

 

 
 

When completing a float search in Fiberworks on a PC, there are a few things to 
understand. 

• There are separate searches for warp and weft floats as shown in the above image. 
• Floats of three threads or less are ignored. 
• Only the visible surface is searched.  To search the other face, choose Change 

Face from the Tie-up menu or click the Back View button on the toolbar, then do 
warp or weft float search again.  

• The longest float found is reported at the left end of the status bar, along with its 
location. The float is also outlined in the cloth drawdown in light cyan (see below on 
the right).  If the cyan outline is hard to see in a color drawdown, it may be 
advisable to switch to a structure view. 

• If the long float is currently off screen, it is scrolled into position so it’s visible on-
screen.  
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Float Search – Mac version 
 
Tools  ®  Float Search 

 

 
 
 

When completing a float search in Fiberworks on a Mac, there are a few things to 
understand. 

• There are separate searches for warp and weft floats as shown in the above image. 
• The minimum float length to search for can be set. 
• The buttons in the lower left corner allow the float search for the front, back, or 

both. 
• Floats found in the draft that meet or exceed the set float length will be listed.  If the 

list is long, the list may be scrolled.  The information about the float will include the 
following: 
o The warp end where the float is found 
o The weft pick where the float is found 
o The length of the float 
o Whether the float was found on the front or the back 

• By clicking a float that appears in the list, the float in the draft will be highlighted.  
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Turning a Draft 
 
You may rotate a draft 90 degrees.  This is called turning a draft.  It is done for following 
reasons: 

• Reduce the number of treadles or shafts 
• Create a single shuttle weave for a compound weave where the original draft required 

more than one shuttle 
• Change the direction of a pattern 

 
This will not only make the threading the treadling and the treadling the threading, it will also 
automatically invert the tie-up  
 
 

PC Mac 
Tieup  ®  Turn Draft 

 
Tools  ®  Turn Draft 

 
 
 
 

Draft Turned Draft 
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Thick and Thin Threads 
 
 There are two ways to change the width of the warp end or treadling pick. 

 
Mouse Method – To change the width of a single warp end or weft pick, clicking on a 
drawing tool (the cursor will change to a pencil).  Click in the space for the end. 

• To make the width wider, click once 
• To make the width narrower, click twice. 

  

 
 

 
 

 
Menu Method – It is possible to use To define a sequence of thick and/or thin warp ends 
or weft picks, Using the Threading and/or Treadling menus, select the Thickness 
option.   
 

 
PC Mac 

Warp  ® Thickness 
Treadling ® Thickness 

 
 

 

 
To change the thickness of an end, click the 
arrow or enter the number. 
 

Warp  ®  Fill Thickness 
Treadling ®  Fill Thickness 

 
 

 
 

 
To change the thickness of an end, click the 
arrow or enter the number. 
 

Thickness bar 
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The thickness tool shown on the previous 
page will allow up to two thicknesses to be 
selected.  The pattern pull-down menu 
allows the following sequences to be filled: 

• All Threads 
• A-B (odd-even) 
• A-A-B-B  
• A-B-A 
• A-B-B-A 
• A-B-B-B 
• A-A-A-B 
•  

The thickness tool shown on the previous page 
will allow up to four thicknesses to be selected.  
The pattern pull-down menu allows the 
following sequences to be filled: 

• Single Thickness A 
• A-B (odd-even) 
• A-A-B 
• A-A-A-B  
• A-A-B-B 
• A-A-A-A-B-B 
• A-A-A-B-B-B 
• A-A-A-A-B-B-B-B 
• A-B-C 
• A-A-B-C 
• A-B-A-C 
• A-A-B-B-C-C 
• A-B-C-D 
• A-B-A-C-A-D 
• A-A-B-B-C-C-D-D 
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Block Substitution 
 

Tools  ®  Block Substitution 
 
The Block Substitution tool allows you to substitute a weave structure into a profile draft.   
 

Step One - First, you need to create or open a profile draft. 
 

 
 

Step Two – From the Tools menu, choose Block Substitution 
 

PC Mac 

 

 

 
 
 

 
 

Step Three – A window will appear that includes block substitution options.  By selecting 
one of the block substitution options, the window will show how many shafts and treadles are 
required.  Click on Apply (PC) or Preview (Mac)to generate a new draft in the weave 
structure based on the profile draft used. 
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Block Substitutions - PC 
Classic weaves 

• Crackle, block form 
• Crackle as summer and Winter 
• Crackle, twill form 
• M’s and O’s 
• Overshot 
• Overshot, multishaft 
• Overshot, multishaft, balanced 
• Overshot, all tabby ground 
• Overshot, tabby ground, balance 
• Overshot, tabby halftone 
• Overshot, tabby halftone, balanced 
• Overshot, single unit tied 
• Overshot, paired unit tied 

 
Damask weaves 

• 4-shaft damask 
• 5-shaft damask 
• 6-shaft damask 
• 8-shaft damask 

 
Double weaves 

• Double weave 
• Double weave, paired threads 
• Beiderwand 
• Beiderwand, half blocks 
• 1:4 Lampas, stitched 
• 1:4 Lampas, stitched, half blocks 
• 1:2 Lampas, twill order 
• 1:2 Lampas, stitched 
• 1:2 Lampas, broken order 
• 1:2 Lampas, stitched, broken 

 
Lace weaves 

• Atwater Bronson 
• Bronson sport 
• Huck blocks, lace effect 
• Huck blocks, spots 
• Huck lace effect 
• Huck lace effect variant 
• Huck spot 
• Swedish lace 

 
2-Tied weaves 

• Double two-tie 
• Double two-tie, reversing 
• Summer and Winter, alternating 
• Summer and Winter, birdseye 
• Summer and Winter, X-style 
• Summer and Winter, Dukagang 

 

2-Tied weaves (continued) 
• 1:2 Extended Summer & Winter 
• 1:3 Extended Summer & Winter 
• 1:4 Extended Summer & Winter 
• 1:2 Extended S&W Dukagang style 
• 1:3 Extended S&W Dukagang style 
• 1:4 Extended S&W Dukagang style 
• 4:2 paired-tie straight 
• 6:2 paired-tie straight 
• 4:2 paired-tie alternating 
• 6:2 paired-tie alternating  

 
3- and 4-Tied weaves 

• Bergman 
• Bergman, half blocks 
• Quigley, diamond 
• Quigley, points 
• Quigley, half blocks 
• Single, 3-tie straight 
• Single 3-tie, rosepath 
• Single 4-tie  

 
Twill weaves 

• Broken twill 
• Diamond twill 
• 3-thread turned twill 
• 4-thread turned twill 

 
Bateman weaves 

• Park weave on opposites (draft 90) 
• Park weave, draft 49 style  
• Park weave, draft 71 style 
• Boulevard on opposites (draft 56) 
• Boulevard, draft 72 style 

 
4-shaft weaves 

• Crackle, polychrome 
• M’s and O’s 
• Overshot 
• Overshot as Summer and Winter 
• Overshot 2-block polychrome 
• Overshot 4 block polychrome 
• 4 block Summer & Winter, alternating 
• 4 block Summer & Winter, birdseye 
• 4 block Summer & Winter, X-style 
• 4 block Summer & Winter, Dukagang 
• Swedish lace 

 



Introduction to Weaving Software using PCW Fiberworks Page 38 
 
 

Copyright © 2001-2019 Robyn Spady  www.spadystudios.com 

Block Substitutions - Mac 
Classic weaves 

• Crackle, block form 
• Crackle as summer and Winter 
• Crackle, twill form 
• M’s and O’s 
• Overshot 
• Overshot, multishaft 
• Overshot, multishaft, balanced 
• Overshot, all tabby ground 
• Overshot, tabby ground, balance 
• Overshot, tabby halftone 
• Overshot, tabby halftone, balanced 
• Overshot, single unit tied 
• Overshot, paired unit tied 

 
Damask weaves 

• 4-shaft damask 
• 5-shaft damask 
• 6-shaft damask 
• 7-shaft damask 
• 8-shaft damask 

 
Double weaves 

• Double weave 
• Double weave, paired threads 
• Double weave, paired, weft only 
• Piqué and Stitched Double Cloth 
• Piqué, figured 
• Beiderwand 
• Beiderwand, half blocks 
• 1:4 Lampas 
• 1:4 Lampas, stitched 
• 1:4 Lampas, stitched, half blocks 
• 1:2 Lampas, twill order 
• 1:2 Lampas, twill order, stitched 
• 1:2 Lampas, broken twill order 
• 1:2 Lampas, stitched, broken 

 
Lace weaves 

• Atwater Bronson 
• Bronson spot 
• Huck Paired Blocks, Lace 
• Huck Paired Blocks, Spot 
• Huck Triple Blocks, Lace 
• Huck Triple Blocks, Spot 
• Huck Lace effect 
• Huck Lace effect variant 
• Huck spot 
• Swedish lace 
 

Summer and Winter 
• Summer and Winter, Alternating 
• Summer and Winter, Birdseye 
• Summer and Winter, X-style 
• Summer and Winter, Dukagång 
 

Summer and Winter (continued) 
• 1:2 Extended Summer and Winter 
• 1:3 Extended Summer and Winter 
• 1:4 Extended Summer and Winter 
• 1:2 ext’d Summer & Winter, Dukagång 
• 1:3 ext’d Summer & Winter, Dukagång 
• 1:4 ext’d Summer & Winter, Dukagång 

 
More 2-Tie weaves 

• Two-color Taqueté 
• Diversified Plain Weave 
• Double Two-tie 
• Double Two-tie, Reversing Twill 
• Double Two-tie, Symmetrical 
• 4:2 Paired Tie, straight 
• 6:2 Paired Tie, straight 
• 4:2 Paired Tie, alternating 
• 6:2 Paired Tie, alternating  

 
3- and 4-Tied weaves 

• Bergman 
• Bergman, half blocks 
• Quigley, diamond 
• Quigley, points 
• Quigley, half blocks 
• Single, 3-Tie straight 
• Single 3-Tie, rosepath 
• Single 4-Tie  
• Single 4-Tie, half blocks 

 
Twill weaves 

• Broken twill 
• 1:2 Turned Twill 
• 1:3 Turned Twill 
• 1:2 Diamond Twill 
• 1:3 diamondd Twill 

 
Bateman weaves 

• Boulevard on Opposites 
• Boulevard on Opposites, draft 56 
• Boulevard, draft 72 style 
• Park Weave on Opposites, draft 90 
• Park Weave, draft 49 style  
• Park Weave, draft 71 style 

 
4-shaft weaves 

• Crackle, polychrome 
• Overshot 
• Overshot 4 Block Polychrome 
• Overshot as Summer and Winter 
• M’s and O’s, 2-Block 
• 4 block Summer & Winter, alternating 
• 4 block Summer & Winter, birdseye 
• 4 block Summer & Winter, X-style 
• 4 block Summer & Winter, Dukagång 
• Swedish lace, 2-block 
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Examples of Block Substitution 
 

Regular tie-up vs Skeleton tie-up 
 

PC Mac 
 
 

Block substitution 
Summer and Winter, alternating 

10-treadle tie-up 

 
 
 

 
Block substitution 

Summer and Winter, alternating 
8-treadle skeleton tie-up 

 
 

 

 
Block substitution 

Summer and Winter, alternating 
10-treadle tie-up 

 

 
 
 

Block substitution 
Summer and Winter, alternating 

8-treadle skeleton tie-up 
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Edit Block – PC version only 
 

The editing of blocks is possible in the PC version of Fiberworks.   
• Select Blank (at the top of the list) or weave structure from the list   
• Click the Edit Blocks button.  
• A window like the one below will appear 

 

 
 

• In this window, the parameters of the blocks may be adjusted.  Note – It is not possible to 
save the block edits, so be careful before clicking on OK. 
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Double Weave 
 
Fiberworks can automatically transform a draft into a double weave pattern,  
 

PC Mac 
Tools  ®  Fold Double 

 

 
 

Tools  ®  Fold Double 
 

 
 

 
Any draft up to 8 shafts can be folded to create a double weave or double width weave 

• Fold Double – requires double the number of shafts and treadles in the original draft 
• Tubular – The rotation of the shuttle connects both sides with one shuttle used in the 

following order: top, bottom, top, bottom.  There are no selvedges in a tubular weave. 
• Separate layers – Requires two shuttles 
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Shaft Shuffler 
 

Fiberworks has a tool that allows the order of the shafts and the treadles in a draft to be 
rearranged without affecting the drawdown.  The tie-up or Liftplan is automatically adjusted. 
 

PC Mac 

 

Tools  ®  Shaft Shuffler 

 

 

Drawing  ®  Shaft Shuffler  
 

Draft toolbar  ®  
 

 
 
When you select the Shaft Shuffler, the mouse cursor turns into a shape with two arrowheads.  
 

Threading Treadling 
 
 

 
When the cursor is over the treading, the 
arrows are positioned up-and-down. 
 
Click on the shaft to be moved and drag it up 
or down to the new location.  A red line will 
indicate the shaft being moved.  Every warp 
end on the shaft being moved is relocated to 
the new position. 

 
 

 
When the cursor is over the treadling, the 
arrowheads face side-to-side. 
 
Click on the treadle to be moved and drag it 
to the left or right to the new location.  A red 
line will indicate the treadle being moved.  
Every weft pick end on the treadle being 
moved is relocated to the new position. 

 
When a draft has a liftplan, the Shaft Shuffler will adjust both the warp ends and liftplan 
simultaneously. The drawdown remains unchanged. If you click and drag within the liftplan, the 
threading will be adjusted also.  Below is an example of a draft with a point treadling (left) with 
the treadles reshuffled (right) into a walking treadling. 
 

Original draft Draft with reshuffled treadles 
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Copying Drafts into Documents 
 
Edit  ®  Copy Image 
 
To quickly and easily copy a draft from Fiberworks to a document (e.g., MS Word), select 
Copy Image from the Edit menu.  This will place the entire active window into the computer’s 
memory.  Then go to the document application the draft will be inserted into and select Paste 
from the application’s appropriate menu.   
 
A couple of things about Copy Image 
 

• Since it copies the content of the active window, it is possible more than the draft will be 
in the image. 

• To capture the entire draft, it is necessary to have the entire draft in the active window.  
Any part of the draft that does not appear in the active window will not be copied. 

 
 
 

Deleting and Copying Components of Drafts 
 

Each component of a draft (e.g., threading, treadling, tie-up, colors, etc.) may be copied or 
deleted using the Select All (PC) or Select Drafts (Mac) feature.  When selected a window 
opens up where components may be selected or deselected by clicking on the check boxes next 
to the various components.  Multiple components may be selected or deselected.  When selected 
it includes everything within the draft component. For example, if the tie-up and treadling from a 
draft is copied to be pasted into another draft, the entire tie-up and treadling sequence will be 
included.   
 

PC Mac 
Edit  ®  Select All 

 

 
 

Edit  ®  Select Drafts  
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Name Drafting 
 

PC Mac 
Tools  ®  Namedraft 

 

 
 

Tools  ®  Namedraft 
 

 
 

 
 
Name drafting is a fun way to create a design from a name, phrase, etc.  Fiberworks allows 
name drafting to create four-shaft overshot designs.  
 
Step 1 - Start with a blank drawdown window 
Step 2 - Go to Tools  ®  Namedraft 
Step 3 - Type a name or phrase into the text box.  A minimum of 8 characters is required.  The 

maximum is 40 characters.  The more names or the longer the phrase, the longer the 
threading will become. 

Step 4 – Click on Apply.  This will create a draft for review.   
Step 5 - Adjust the parameters and click on Apply until the desirable pattern is achieved. 
Step 6 – Click on OK (PC) or Accept (Mac) the draft pattern. 
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Sketchpad (PC version only) 
 
File  ®  New Sketchpad 
 
Fiberworks may be used for fabric analysis and develop a draft while figuring out how fabric 
was created.  The New Sketchpad feature on the File menu creates a unique editing mode. 
 
By choosing New Sketchpad, a window opens with a grid.  Above the grid are drawing tools. 
 

 
 

Sketchpad Drawing Tools 
 
 

 
 

Sketchpad 
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Using the drawing tools, it is possible to create designs on the grid. 
 

 
 

When the design is complete, go to Analysis  ®  Make Drawdown.  The window below will 
appear. 

 
 

Click on Make New Drawdown and a profile draft will be created.  
 

 
 
Use Tools  ®  Block Substitution to create a weaving draft from the profile draft. 
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Printing 
 

Drafts and components of drafts may be printed.  Printing is also a way to get the threading, 
tie-up, and treadling in numbers.  Below are the PC and Mac screens that appear when the 
print command is selected from the File menu. 
 
PCs - File  ®  Print Preview 

 

 
 

Macs - File  ®  Print 
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Network Drafts  
 
Using the Freehand Draw tool, draw a curving line in the threading and/or the treadling area. 
 

 
 
Warp  ®  Redraw on Network 
 
Treadling  ®  Redraw on Network 
 

PC Mac 

 
 

 

 
 

 
 
Adjust the parameters of the network components and click Apply. 
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Integrated Threadings and Treadlings 
 

Fiberworks provides the ability to integrate threading and treadling sequences. 
 
Start with a threading or treadling sequence 
 

 
 

Warp  ®  Parallel Repeat 
 
Treadling  ®  Parallel Repeat 
 

PC Mac 
 

 
 

 

 

 
Selecting Add shafts above or Add treadles right (PC) or Add extra treadles (Mac), the 
original sequence is duplicated by adding shafts above the original sequence for the threading or 
adding treadles to the right.  
 

 
 

Selecting Extended parallel, the original sequence is interleaved with the same sequence 
without increasing the number of shafts or treadles, but offset by the number in the shafts shift 
by box. 

 


